EndNote X3

Table of contents
1. Adjustments before start ................................................................................................................. 3
2. Create a Library - write references ............................................................................................... 3
3. Fields in a reference .......................................................................................................................... 3
4. Import references with a Connect / Online search ......................................................................... 6
5. Import references with filter ......................................................................................................... 7
   Ebsco ................................................................................................................................................ 7
   Ovid SP ........................................................................................................................................... 7
   PubMed .......................................................................................................................................... 7
   CSA................................................................................................................................................ 8
   Cochrane ....................................................................................................................................... 8
   Zotero ............................................................................................................................................ 8
6. Import from databases with direct export ....................................................................................... 9
   Web of Science ................................................................................................................................. 9
   Ebsco host .................................................................................................................................... 9
   APA: ............................................................................................................................................. 9
   OvidSP ......................................................................................................................................... 9
   Google scholar .............................................................................................................................. 10
   SFX ................................................................................................................................................ 10
7. Edit ................................................................................................................................................ 11
   Copy references between libraries: ................................................................................................. 11
   Clear references from Group ........................................................................................................... 11
   Copy formatted ............................................................................................................................... 11
   Change text .................................................................................................................................... 11
   Output styles ................................................................................................................................ 11
   Import filters ................................................................................................................................ 11
   Connection files ............................................................................................................................. 11
   Preferences: make your adjustments in the program here .............................................................. 11
8. References ..................................................................................................................................... 14
   Move references to trash .................................................................................................................. 14
   Hide or Show references ................................................................................................................ 14
Record summary .................................................................................................................. 14
Finding duplicates .................................................................................................................. 14

9. Groups ............................................................................................................................. 15
   Create a group .................................................................................................................... 15
   Create a smart group ........................................................................................................ 15
   Add references to .............................................................................................................. 15
   Creating a Group set ........................................................................................................ 15
   Hide groups ....................................................................................................................... 15

10. Tools ............................................................................................................................... 16
    Search the Library ........................................................................................................... 16
    Change and move fields ................................................................................................. 16
    EndNote Web .................................................................................................................... 16
    Term lists, lists ................................................................................................................ 16
    Keywords ........................................................................................................................ 16
    Journals ............................................................................................................................. 17
    Sort the references in a library ....................................................................................... 17
    Library summary ............................................................................................................. 17

11. Cite While you Write, CWYW ...................................................................................... 18
    Styles ............................................................................................................................... 18
    Format citations and bibliography in Word processor 2007 ............................................. 18
    Unformat citations .......................................................................................................... 19
    Edit citation .................................................................................................................... 20
    Convert to plain text / Remove field codes ................................................................... 20
    Footnote .......................................................................................................................... 20
    Traveling Library .......................................................................................................... 21

12. Create an independent bibliography ............................................................................. 22

13. Insert pictures and files ............................................................................................... 23
    Insert pictures in your library ........................................................................................ 23
    Insert pictures in a word document .............................................................................. 23
    Insert files in your library ............................................................................................. 23
    Inserting a file in your text ............................................................................................ 23
1. Adjustments before start
Go to Edit, Preferences, click on Term lists. Remove the mark in “update lists when importing” click on OK.

Before adding references into your library go to page 17, see Term lists and Journals.

2. Create a Library - write references
1. Open a new library. File, New, give the file a name e.g. anna.enl. Save
2. Put in a new reference References, New Reference
4. The information is automatically saved when exiting the reference.
5. Always save a copy of the library. File, save a copy. Place the copy in the Endnote map or on a USB

3. Fields in a reference

Author
Authors name should be as follows: Surname, First name Second name
Alexander, George Carl
Lee, S.Y.D.
Smith, Alfred, Jr
De Gaulle, Charles
OR
Ian Smith.

Punctuation should be after initials.
Press enter if more than one author. Every author or editor should have his or her own line to be searchable. Endnote puts automatically in “et al” if it’s necessary.
If the author is an institution or a firm writ the whole name and put a comma at the end of the name. For example: Niles Software inc., No comma in the middle of a name.

To see all the authors in your library you can make the adjustment under: Edit, Preferences, Display fields. Make a mark in where it says “Display all authors in the field”

Year
Use four digits. Put in press or submitted if needed.
Title
Write the whole title without using the enter button. Don’t use a point or any other punctuation mark. Subtitles can be separated with colon. For example:

Privatization of the British rail: An economic analysis

Journal
Write the full journal title or the abbreviation.

Pages
Page ranges can be entered as complete (1442-1449) or abbreviated (1442-9) ranges. The style used to create the bibliography can change the page numbers to be either full or abbreviated page ranges, or show just the first page.

Reprint Edition
Do not write the word edition or Ed. Or Eds, but 1st or 2nd

Short title
Use the Short Title field to enter abbreviated versions of the regular title which should be used as part of an in-text citation or a footnote citation. This is a common request for many of the humanities styles which use a shortened form of the title in the citation to help identify which reference is being cited.

Alternate Journal
The Alternate Journal field is most useful when importing or retrieving references from an online source that provides two forms of each journal name (full and abbreviated). By importing both, you can easily update the Journals term list and use the correct form of the name without having to enter it yourself

Keywords
If you make a search in a database the keyword can be a part of the information. You can write in them directly in to the reference. Two or more keywords are separated with semicolon. You can also find keywords in the Term List.

Abstracts
When you make a search in a database containing abstract it automatically ends up here. You can also copy and paste. It can contain up to 5 A4 pages.

Research Notes
Used for your own notes.

URL
In The URL field you can put links to full text or to another web page or other files.
File attachments in three different ways

1. Save a pdf on your computer. Place the marker in the field file attachments. Make a right hand click. Choose attach file. Find your PDF and open it. A link to your PDF file is now saved in your library. You can have up to 45 files in a reference.

2. Drag and drop your PDF directly into the File attachments field.

3. Mark or open the reference of your choice. Go to References, Find fulltext. Or make a right hand click. Follow the instruction that you see on the screen. Endnote is now collecting the full text. When the procedure is finished you will see a PDF icon in the File attachment field. If you can’t see any full text, the problem can be that you do not have the right to download the full text, or it just does not work. Then try alternative 1 or 2.

If you want to copy your Library to a USB memory or another computer and still be able to read your pdf you have to save your library under: File, compressed library. You can specify whether to save file attachments with the library or not. You can specify if you want to compress and email or specify whether to save all references to the compressed library, or only the selected (highlighted) references, or only the references in a specific group.

Figure
Field to put pictures or files. You can only have one object in this field. To have more files in your reference put it in the in file attachments.

Caption
Name the picture or the file so that you can easier find it.
4. Import references with a Connect / Online search
Make a search through EndNote and import references with online search. The Online search situation at this moment is that you can only do a remote search in PubMed, Swedish national library (Libris), Umea U (our local library catalog), Web of science and other library catalogs.

1. Open a library in Endnote.

2. Tools, Online search, New search, Choose a database from the list, if you haven’t made a choice before.

3. The Library Window Display Modes
You can choose from different display modes in the Library window. You may want to always work in Integrated Library & Online Search Mode, where all groups and commands are available. When you download references from an online database, they are saved directly into your open library.

The other option is to work primarily in Local Library Mode and switch to Online Search Mode when you want to search and download references from an online database. In Local Library Mode, the Online Search groups are not available; once you select the Online Search command from the Tools menu, you are automatically switched to Online Search Mode. In Online Search Mode, only the Online Search groups are available, and references are downloaded into a temporary library. This allows you to download references from online databases without affecting your local library. Many library commands are not available in Online Search Mode.

To switch between these modes, click on the appropriate toolbar button:

4. Fill in the form that opens up, choose AND, OR NOTE. With “Add field” you can choose more words to combine with. It is possible to save the search also.

5. Click on search

6. Confirm remote search will show with the number of hits. Click OK if you are content otherwise go to cancel. You will come back to the formula add more search words or delete.

7. Mark references if you don’t want to import all references.

8. Go to Copy x reference to: choose library, click. The new references will be in the library of your choice. You can also create a new library.

9. To make a new search go to clear list and return to search. Put in new search words. If you do not click on clear list the references from the first search will still be there.
5. Import references with filter
Make a search in a database, save to the disc, and import with filter

Filter is a file in Endnote that you need for importing the references from different databases. The purpose for this is so that the fields will look right in the reference list. So that the author is in the author field and so on.

A. Database vendor

Ebsco
1. Make a search.
2. Mark references by click on add to folder.
3. Go to Folder views.
4. Mark the references one more time.
5. Click on export, mark “generic bibliographic managements software”
6. Click on save.
7. The references you have saved are now shown.
8. Choose file, save as. Name the file * *.txt

Ovid SP
1. Make a search.
2. Mark or choose all the references.
3. Go to Result manager on the left side. Choose fields under FIELDS.
4. Choose Reprint/Medlars-format. Under RESULT FORMAT
5. Choose Save under Action, mark if you are using windows, mac or unix. Press Continue.
6. Name the file , and save it as a text document * *.txt

PubMed
1. Make a search.
2. Mark references that you want to download.
3. Choose Send to, File and Format Medline and Create File.
4. Name the file and save it as a text document * *.txt.
CSA
1. Make a search
2. Mark or choose all the references
3. Click on save, print, e-mail
4. The record format should be “full”
5. Mark the option for mac or pc, SAVE
6. Name the file and save it as a text document *.txt.

Cochrane
1. Make a search.
2. Mark references or choose all the references.
3. In the end of the result list, you can choose between Export selected citations or Export all results.
4. Choose Export type and File type, press Go.
5. Save the file.

Zotero
1. Open Zotero in Firefox web browser.
2. Mark the hole library or just a collection, make a right click.
3. Choose the format Refer/BibIX.
4. Save the file.
5. When you open the file in Endnote Web you must use the filter Refer/BibIX.

B.
Go to Endnote, open a library

1. File, Import, import data file
2. Choose file. Look up the file you have saved.
3. Go to Import option and choose filter. If needed go to “other filters”
4. Use Text translation if characters do not appear as they should in EndNote.
5. Click on Import.

The new references are shown in a group called imported references. To see all references you have to go to References, Show All References.
6. **Import from databases with direct export**

Export references directly into Endnote without using a filter. When the references are imported into your Library they are shown under *Imported references* until you make a new export/import but they also end up at the same time in your library, *All references*.

**Database vendor**

**Web of Science**

Science Citation Index Expanded, Social Sciences Citation Index, Arts & Humanities Citation Index

1. Make a search in Web of science
2. Mark the reference(s) of your choice.
3. Click on the link *More Options* at the head of the record list.
4. Make your choices in step one and two and in step three, “*Save to Endnote, RefMan or other reference software*”.
5. Select a Reference Library on your hard drive for example under My documents if you placed your EndNote library there.

**Ebsco host**

1. Make a search in selected database
2. Add references to your folder
3. Click on *Folder has items*
4. Choose export
5. Click on “*Direct export to EndNote*...” and *SAVE*
6. Select a Reference Library on your hard drive for example under My documents if you placed your EndNote library there.

**APA:**

1. Make a search in selected database
2. Mark the reference(s) of your choice.
3. Click on *Export*. Choose *Export to: Reference Software* and *GO*.
4. In the window that opens Choose to *Open* the file. Fileformat is PsychINFO_Eport.ris
5. A new window open where you can Choose Destination. Choose EndNote.
6. Find your EndNote Library on your harddrive and make a double click.

**OvidSP**

Medline, PsychInfo

1. Make a search in selected database
2. Mark the reference(s) of your choice.
3. Go to *Results manager* on the left side of the page. You can select results in step one, choose fields in step two and in step three, *Result format*, send the records with *Direct export*.
4. Scroll to the top of the Result manager and *SAVE*
5. Chose *Export results to Endnote*...
6. Select a Reference Library on your hard drive for example under My documents if you placed your EndNote library there.

**Google scholar**
1. Go to the Google scholar homepage [scholar.google.com](http://scholar.google.com)
2. Click on the Scholar Preferences link
3. Under “Bibliography Manager” select the option “Show links to import citations into” and choose Endnote in the drop down menu.
4. Click on the “Save Preferences” button

Follow these steps to import search results to EndNote:

1. After performing a search on Google Scholar click on the "Import into EndNote" link for the reference you want to import
2. If you are presented with a window asking if you want to "Open" or "Save" the file, choose to open the file, otherwise proceed to step 3
3. A "Select a Reference Library" window will appear, use this window to select the EndNote library you want the reference imported into

**SFX**
You can also try to import records to EndNote with SFX. If the record in any database are supplied with a SFX icon you can open SFX and use the function Referenshantering.
A "Select a Reference Library" window will appear, use this window to select the EndNote library you want the reference imported into
7. Edit

Copy references between libraries:
1. Mark one or two references.
2. Choose Edit, copy (or Ctrl + c)
3. Open the library where you want to put the new reference and insert it with Edit, paste (or Ctrl + v)

Clear references from Group
This function discard highlighted references from a group but not from the EndNote library.

Copy formatted
Mark your references and choose a style. Click on copy formatted. Go to word use ctrl V or paste. You will now have a list of your library.

Change text
This is similar to Change and move fileds, but you first have to pick a filed, then make a search in that filed and in the end you change that word to something else.

Output styles
The EndNote Styles collection contains more than 3000 bibliographic styles for a variety of disciplines. You can choose styles, in Open Style Manager, to be seen in the drop down menu at the toolbar. You can also Edit a style and create your own style.

Import filters
Import filters are the files used by EndNote to transfer information previously downloaded from an online database. You can choose filters here to be seen under Import options (File, Import, Import options).

Connection files
Connection files contain all the information necessary for EndNote to search and import references from an on-line database. You can choose databases, in Open Connection Manager, to be seen as a firsthand choice for Online search under the Tools menu. You can search databases that are free on the internet for example Pubmed and Swedish National Library. You can also search in Web of science owned by Thomson publisher.

Preferences: make your adjustements in the program here
Set Endnote preferences, for example, Reference Types, Term Lists, Url’s and Links’ etc.

Choosing a Library to Open:
Use the Libraries preferences section to specify which libraries should open by default when you start EndNote.

Reference types:
Use the Reference Types preferences panel to customize your settings for the fields (such as Author, Year, and Title) and reference types (such as Journal Article or
Book) that are used by EndNote. Any changes that you make in this panel apply to all of the libraries that open on the computer.

Make a new field:

Go to *Edit, Preferences.*
1. Choose *Reference Types,* click on *Modify Reference Types*
2. Go down to Custom 1 or Custom 2
3. Give the field a name e.g. “My notes”. You can change the field so that you can see it on every reference type.

Display fields in a library:
Use the *Display Fields* preferences to choose which fields to display in EndNote’s Library window. These settings apply to all libraries opened on the computer.

To access these settings, go to the *Edit* menu, choose *Preferences,* and click on *Display Fields* in the list of preferences.

Duplicates:
Set criteria for EndNote to find duplicates. By default, EndNote identifies duplicate references in a library as references of the same reference type with matching Author, Year, and Title fields.

Term lists:
By default, every new EndNote library has three term lists associated with it: Authors, Journals, and Keywords. The term lists are automatically updated as you enter references into your library and suggests terms as you type.

You can turn off, *Update lists when importing or pasting references* and *Update lists during data entry,* to stop Endnote from overwrite imported journal lists. See page 3 and 17, Journals.

EndNote Web:
The EndNote Web preference panel saves subscription details for connecting to EndNote Web.

Find Full text:
The *URL>OpenURL Link* command on the *References* menu starts your default web browser and displays the full text article. It connects to an OpenURL standard syntax server and uses these OpenURL preferences along with data in your EndNote record to find related online references.

*OpenURL path* for Umeå University library: http://link.libris.kb.se/sfxumub

If you want to reach full text outside the campus net use *Authenticate with:* http://proxy.ub.umu.se/login
Make a right click on the reference you want to download pdf to. Use *Find full text* and *Authenticate.* A window with CAS - Umeå University authentication service
opens. From here you can reach the library's Journal index. Look up the article and save the pdf at your harddrive.
8. References
Edit references in your Library. Use References, Edit references or make a double click on the reference that you want to open. If you want to do a global editing among your references you can use Change and Move fields or Change text under Edit. These commands can automatically add a term to all or some of your references. These are useful tools for labeling groups of references as well as for fixing common typos or spelling mistakes.

Move references to trash
Mark references to move to trash.

Hide or Show references
Mark references in a library and choose Hide references or Show references. Go to references; show all references to see the whole library again

Record summary
Gives you more information about a specific reference in the library.

Finding duplicates
When Endnote finds duplicates it compares the following fields: Author, year title, reference type.
Open your library.
Choose Find duplicates from the Reference menu. The references that are duplicates are now marked. To delete go to Reference menu, Delete Reference or use the delete button. Always delete the references that Endnote suggests it’s the Endnote number that controls the deleting process.

Important: There is no UNDO in Endnote, when a reference is deleted it’s gone.
9. Groups

Create a group
Create a group to your library. Give a name to the group. It’s easy to change the name, just make a right hand click. Every library can have up to 500 groups. You can easily move references with “drag and drop”.

Create a smart group
A smart group is based on a search strategy that you first perform in the search formula. The group will then be updated automatically when new references is added that matches your search.

To make a smart group:
1. Choose groups, create smart group.
2. Make a search according to the references you want to collect. Choose create.
3. Choose a suitable name for the search. Rename group from the Groups menu.

Add references to
Add references to a group.

Creating a Group set
A new library begins with a single custom group set titled My Groups. However, you can create up to 500 custom group sets in your EndNote library.

From the Groups menu, choose Create Group Set. You can drag groups from other group sets to create subgroups or create a new custom or smart group as a subgroup.

Hide groups
Hide a group if you feel that the list is too long.
10. Tools

Search the Library
There are two ways to search the library: **Quick search** and **Search references**. Quick search gives you a fast search directly in a library. For a more detailed search, choose search library. Open the library you want to search in. You can only search one library at the time. To find a specific author just write a few letters in the authors last name.

For a more advanced search go to **Search references** under the **Reference menu**. Choose a specific field and combine with and, or, not. You can save a search and then make the same search in all of the libraries. With Endnote X you also have the option to search fields begins with, fields ends with and the first letters in a word.

Change and move fields
Change information in a lot of references at the same time. First hose references by marking or searching. Click on change and move fields. Choose filed, choose how the information is shown. Write your text, click OK.

EndNote Web
With **Endnote Web transfer references** you can transfer your references between your web account and Endnote desktop. All you need is to register on Endnote Web [www.endnoteweb.com](http://www.endnoteweb.com)
Only available in EndNote XI and forward.

Term lists, lists
When importing references to a library the journals, authors or keyword term lists are not updated automatically if you have unmarked the “update term lists when importing” under **Preferences** (page 4). If you want to update your library anyway, go to **Tools, Define term lists**, and mark what kind of list you want to be updated, click on **Update lists**. Mark what kind of list you want (again). Click on, OK. Endnote will paste the information from your library into the list.

Keywords
To look for keywords that are already in Endnote you can find them under **Tools, Open term lists**, and **Keywords**. Open your library and open your reference. Place the marker in the keyword field. Go to **Tools, Open term lists, Keywords** mark the key word(s) you are going to put in the reference and click **Insert term**.
Journals.
You can use this list to find the whole name or abbreviation for journals. **Tools, Open term lists, Journals term list, Mark lists**, click on **Import lists**. Make sure that you find the Endnote software on your computer, if not browse to EndNote under Program and click on the map **Term lists**, and mark e.g. medical, **Open**. You will have a list with about 9000 journals in your library. You can also find term lists in other subjects.

When you format your document (see page 19) the information is connected to those lists. If you for example use the style for Vancouver for you reference list the journal name should be abbreviated. Endnote uses the information from the Journal term lists to fill in the abbreviation.

If you can’t find the journal in the term list you can manually add it. Click on **Tools, Open term lists**, and choose **Journals term lists**, click on **New term**. Fill in the form.

Sort the references in a library
It is easy to temporary sort the library in another way. In the library just click on the line of the head of the author and they will sort in a alphabetical and chronological order. It’s the same thing with title and year. You can also sort the library under **Sort references** in the **Reference menu**. Note that this will change the sorting order even after closing the library.

Library summery
Gives you information about the whole library, how many references etc.
11. Cite While you Write, CWYW

**Styles**

Many journals have specific demands on the format of an article when you want to publish with them. When you choose a style the bibliographic citation will be influenced. Endnote contains of about 3700 different styles. If you would like to see how your reference looks like in a specific style you can click the preview button in your library.

There are some styles that allow you to sort your list for your self:

- Acta haematological
- Journal of American medical association
- Journal of clinical investigation

**Different styles - Style Manager**

Mark your favorite styles by *Edit, Output styles, Open style manager*. You can choose between your marked styles from the drop-down menu:

On Endnote’s home page you can find more styles [http://www.endnote.com](http://www.endnote.com), Support & services, update to the latest Styles.

**Format citations and bibliography in Word processor 2007**

**Format** is the process where word and Endnote works together to create a reference list in word.

**Formatting in Word 2007**

1. Open your word document. Write your text, put the marker where you want the reference to be and make a space.
2. Open a library in Endnote. Mark the reference of your choice, open word, use the EndNote toolbar and *Insert Citation > Insert selected citation(s)* or use *Insert Citation > Find Citation*.
3. A Reference list is created with the function “Cite while you write”
4. When you are finished with your work save the work in an unformatted version.
5. Next time you open your word document and want to see the reference list do as follow: open your document, choose a style for example Vancouver from the *Style*; drop down menu, *Update Citations and Bibliography*. 

You can also choose to create a bibliography for each section in the document or create a bibliography for each section and also a complete bibliography at the end of the document. Not only at the end of the document. To do that go to Edit, Output Styles, Open style manager. Mark the style and choose Edit, Sections:

In Word you have to break your documents into sections for EndNote to understand where you want to have your bibliography.

In Microsoft Word 2003:
From the Insert menu, choose Breaks, and then select one of the four options under Section break types: Next Page, Continuous, Even Page, or Odd Page.

In Microsoft Word 2007:
On the Page Layout tab, click on Breaks, and then choose one of the four options under Section Breaks: Next Page, Continuous, Even Page, or Odd Page.

Unformat citations
Unformatting reverts formatted citations to temporary citations, removes the bibliography, and turns off instant formatting. Your citations in the text will look like this: "{Smith, 1999 #25}".

Convert Citations and Bibliography > Convert to Unformatted citations.
To format it again: choose a style from Style, drop down menu > Update Citations and Bibliography.

EndNote assigns a unique record number to each reference as it is added to your library. These record numbers appear in the temporary citations to ensure that the correct reference is used when the paper is formatted.
You may also see record numbers in the Library window by choosing Record Numbers as one of the display fields for the Library window. See Display Fields in a library at page 13.

**Edit citation**

When changing information in a citation use the *Edit citation*. You can add pages, insert specific information or delete author names. Note that this doesn’t work with numbered styles.

Use Edit citation to delete a citation from your text. Highlight the reference and Edit citation. Mark the references in *Citations in document* and *Remove*.

**Convert to plain text / Remove field codes**

If you cannot find a suitable style maybe you can find one that is almost the same and make changes in your word document after removing field codes. When you are finished with your text you got to remove filed codes from the tools menu. Follow the instructions. *Once the field codes are gone you will have an ordinary word document that is not connected to EndNote*. It’s important that you always save one copy of the formatted document.

**Footnote**

Use the appropriate command in Word, *References* and *Insert footnote*, to create the footnote or endnote. EndNote does not create the footnote or endnote in the document, but is used to insert and format citations in the note.

1. Put the cursor in the text where you want your citation. Use the footnote command in Word. The cursor appears automatically in the footnote.
2. *Insert citations* from the Endnote tab.
3. The EndNote style that is selected when you choose *Format Bibliography* determines how citations in footnotes and endnotes are formatted.

Change the apperance of your footnote from inside the Endnote program. From the *Edit* menu choose *Output styles*, mark the style you want to change and click on *Edit* to make the changes.

Click on the menu *Footnotes* and *Templates*.

From the drop-down menu you have three options:

1. Same as bibliography
2. Same as citations
3. Using footnote format

If you want the footnotes to be the same as bibliography or if you want them to look like in text citations or if you want to make your own format use one of the options in the drop-down menu. Use the third option if you don't want to include citations in bibliography. Choose Reference types and Insert field to make your own format.

Repeated citations - One common setting for citing references in footnotes is to list a shortened form of a reference after the first time it is cited in a footnote.

Check the option to Include title/short title if you would like both the author and the title to appear in the shortened form of the footnote references. The contents of the Short Title field will be used, if available; otherwise, the regular title will be added to the citation.

When the same reference repeats in consecutive footnotes, you have the option of replacing the repeated data with text of your choice. This is normally "Ibid".

If the same source repeats in consecutive footnotes it does not apply to the identical reference that repeats in consecutive footnotes, but rather if any of the source data repeats in two consecutive footnotes. For example, if two different references happen to be from the same journal, these settings would apply to the journal name, volume, and issue.

Traveling Library

If there are 2 or more authors on an article or a paper you can use traveling library. Person number 1 writes an article with references from EndNote, saves it formatted, and sends it to person number 2. Person number 2 continues to write the text and place references in the text. To save the references in it's own library go to the tools menu and Export Traveling Library. It's recommended that you save it in a new library. Person number 2 sends it to person number 1 who continues to write on the text. The best thing is to use the same style for the text and you have to use the same version of EndNote.

One alternative way to Traveling library is to send your word document as an attachment with mail or via USB. Your colleague can continue working with the document. If you want to put in her or his references into your library you have to insert them one by one when you Update citations and bibliography.
12. Create an independent bibliography
There may be times when you want to create a bibliography without an associated paper.

Print Preview:
An easy way is to open your library under “file” choose “print preview”. Choose print. Just remember that depending on what style you have the bibliography will follow always follow the style

Copy formatted or drag and drop to a word processor:
1. Open the library of your choice.
2. Mark the references for your bibliography.
3. Go to Edit, copy formatted or Ctrl C.
4. Go to word. Open a document.
5. Edit, paste or ctrl V
6.

Export references:
1. Open the library of your choice.
2. Go to Edit, output styles.
3. Choose style.
4. Mark the references for your bibliography.
5. Go to File, export.
6. Choose where you will save the file, name it and save in HTML- or rtf-format.
7. Open the file.

Subject bibliography:
1. Open your library.
2. Go to Tools, subject bibliography.
3. Choose a field for your headline e.g. author.
4. Click OK.
5. Click on select all. OK
6. You will have a reference list /bibliography accordingly to the field of your choice.

NOTE. There is a problem with references that have no author. Make a search for the reference and put in Anonymous in the author field.
NOTE this will give you a list with all the authors. To have a smaller list, chose year under the subject menu. Under the different years your references will appear.
13. Insert pictures and files

Insert pictures in your library
   1. Open your library.
   2. Open the reference where you want the picture, go down to the field where you can see figure. Put the marker there
   3. Go to References, insert figure. Navigate to the picture of you choice. Click on it.
   4. In Caption field you name the picture so it will be searchable.
   5. Only put in one picture in one field.

Insert pictures in a word document
   1. In Word open your document, go to Tools and Find figures
   2. Find the picture of your choice.
   3. When you found it Insert

Insert files in your library
   1. Open a reference. Or make a new, choosing reference type "Chart or table"
   2. Write your text in the reference.
   4. Browse for the file or your choice. Click on it
   5. Name the file in the caption field.

Inserting a file in your text
   1. Go to tools in Word and Find figures
   2. Choose the searched file
   3. When you found it Insert
For questions and help call UMDAC support 786 63 00 or

University Library
Maria Nyman 786 94 91  
maria.nyman@ub.umu.se
Sofia Pemer 785 85 32  
Sofia.permer@ub.umu.se

Alfasoft AB provide support for its product
www.alfasoft.se/support.html

You find FAQ at www.endnote.com/support/

Flowchart for Endnote: